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1. Requirements before starting the installation

Before starting the installation, make sure that you have everything you need at hand.

Master remote control 22AV8573 or Guest remote control 22AV1407A

And

USB stick

To enter the Hotel TV menu using the guest remote (22AV1407A):

For all HFL2809 models you can use the guest remote and the key sequence 3,1,9,7,5,3,MUTE to access the Hotel
Mode. The key sequence will not work if High Security Mode is enabled.

To enter the Hotel TV menu using the master remote control (22AV8573):

® Press the RC5 Setup key;
* Press the Home/Menu key;

Note:
The Home/Menu key on the master remote control (22AV8573) will activate only the hotel menu, navigation in this
menu must be done with the guest remote (22AV1107A).

Exit Hotel TV Menu
Leaving the Hotel TV Menu after making the required settings, can be done using the master Remote Control
(22AV8573) or with the TV included standard Remote Control.
To exit the Hotel TV menu with master remote control:
® Press the RC5 Setup key;
* Press the Home/Menu key;
To exit the Hotel TV menu with standard RC:
- Press the Menu key or
- Press the Return key

Note: On the bottom part of the screen the TV will display which buttons can help you to navigate and change the
options.
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2. Find out the state of the TV

It is important to know if a TV is in ‘virgin mode’ (out of the box) or installed before.

If you can see this screen below, you know that the TV is in ‘virgin mode’ and you can install the set. See chapter 4 of
this manual.

First time installation

Bienvenue ! Veuillez choisir une langue. Frangais
Willkommen, Wahlen Sie bitte lhre Sprache aus! Deutsch
Benvenuti, Selezionate la vostra lingua! Italiano

Bienvenido, seleccione un idioma Espaiiol
Hos geldiniz, litfen dil secimini yapiniz! Tiirkge
Dobrodosli, izberite vas jezik! Slovenski
Udvozoljiik, kérjik valassza ki a nyelvet! Magyar
Bem-vindo, favor selecionar seu idioma Portugués
Dobro dosli, molim izaberite svoj jezik! Hrvatski
Prijemny def, zvote si jazyk! Slovencina

[W]A]Select Language @59! language

If you power on the set and then press the ‘Home’ button on the guest remote, you will see this screen appear, if the
TV already has been installed or the wizard was already skipped.

Hotel TV menu is ON

Picture

Hotel TV menu is OFF
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You can start the installation wizard again by reinstalling the TV as explained in chapter 3 of this manual. To be able
to modify any settings on the TV you must disable the Hotel TV mode.

Disable the Hotel TV mode

To access the setup menu you should press the ‘RC5 SETUP’ key and then press the ‘Home/Menu’ button if you are
using the 22AV8573.

To access the Hotel TV menu using the guest remote you need to input the key sequence 3,1,9,7,5,3, MUTE .

You can use the guest remote to select with the up or down arrow buttons and change values with the left or right
arrow buttons. Set the Hotel TV Mode to OFF.

Hotel Mode

Off
HDMI1

Disabled

Disable Setup Menus

N

Press “MENU” or “Return” button to exit this menu.

Note: Setting Hotel mode to OFF will disable all features from the Menu.



3. Re-install TV

If you want to start an installation from scratch you can always re-install the TV. First step is to set the Hotel Mode
to OFF and exit using the MENU or Return button on the guest remote.

Hotel TV Menu

Pin8 Off

Last Status off

Panel Lock off

RCU Inhibit off

Startup Position

Startup Channel 1

Volume Limit )
Fixed Volume Enable off

Fixed Volume Value

Headphone Direct Volume Disabled

Osd Disable Disable Setup Menus

Teletext On

[Ia]Navigate m}:]Chfange Value
@ Back Exit

Note: It is not required to use a save button, once you exit the menu, you will save the settings from the Hotel TV Menu

Press the MENU button on the guest remote to access the full menu of the TV. The following menu should be
displayed. Select the option “Install and Retune” (highlighted below)

G % Y v .

Install and Retune

Press “OK” to access the submenu.
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Select the last option available “First time installation” and press “OK”. The TV asks for confirmation by showing the
following screen:

‘ B Install and Retune

Automatic channel scan (Retune)

Manual channel scan
Network channel scan

Analogue fine tune

If you are sure that you want to re-install the TV, select “Yes” and press OK.

Do you want to delete all channels and
settings for first time installation? TV

will be reset.

The TV will reboot itself and show the “virgin state” screens with a welcome message.

Note: All settings will be reset to default values except Hotel menu values. Those values will remain the same. To reset the Hotel
TV menu use the Reset to Default Values option present in that menu.
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4. Installation wizard

When you turn on the TV for the first time, or you have reinstalled the TV, you should see the following screen. The
installation wizardof which this screen is a part, will guide you through all the menus for a basic TV installation.

First time installation

Bienvenue ! Veuillez choisir une langue. Francais
Willkommen, Wahlen Sie bitte lhre Sprache aus! Deutsch
Benvenuti, Selezionate la vostra lingua! Italiano

Bienvenido, seleccione un idioma Espanol
Hos geldiniz, litfen dil seimini yapiniz! Tiirkce
Dobrodosli, izberite vas jezik! Slovenski
Udvozoljiik, kérjik valassza ki a nyelvet! Magyar
Bem-vindo, favor selecionar seu idioma Portugués
Dobro dosli, molim izaberite svoj jezik! Hrvatski
Prijemny ded, 2volte si jazyk! Slovencina

[W]A]Select Language @]Sel language

Please select your language and press “OK” to start the installation of the TV set.

The first step is to select the country, which will enable country cable providers, time setting and channel list presets.

First time installation

Welcome!

Search Type Digital only
Teletext Language West

Scan Encrypted Channels Yes

[T&] select Setting €] thoose your country [oK] Start search

The next step is to select what type of TV channel search that you want to perform:

- Digital only: TV will search only for digital channels
- Full: The TV will search for digital and analog channels
- Analogue TV only: The TV will search only for analogue channels

Note: On the bottom part of the screen the TV will display which buttons can help you to navigate and change the
options.

Once you have set up the channel search, you can press “OK” to go to next step of the installation.
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Depending on country you might need to follow an additional step, setting up a pin code. This pin code will be used
for blocking TV channels and settings.

Enter PIN

In some cases due the country regulations, you have to provide a pin code formed from four digits. This pin code will
be required in case you want to modify the settings of the TV. Selected PIN code cannot be 0000. Enter a PIN code
and confirm it by entering it once more. Press the OK button to continue. If the two PIN codes match, your PIN code
will be set.

WARNING:
When you are required to enter a PIN code for any menu operation, you should use the PIN that you have previously

defined during the first time installation.

Press “OK” to continue to the next screen, which will ask if you want to start an automatic channel scan.

Do you want to start an automatic
channel scan?

————————e—

Select “Yes” and press “OK” to continue.

The next screen is asking about what the type of channels that will be installed.

Please Select Digital Search Type

D seiciscable
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Aerial Installation
If you select the AERIAL option in the Search Type screen, the TV set will search for digital terrestrial TV (DVB-T)

broadcasts.
NOTE: You can press the “MENU” button to cancel.

After all the available stations are stored, the Channel List will be displayed on the screen. If you like to sort the
channels according to the LCN (*), please select “Yes” and then press OK.

Press the “MENU” button to quit the channel list and watch TV.
(*) LCN is the Logical Channel Number system that organizes available broadcasts in accordance with a recognizable channel sequence (if
available).

Cable Installation
If you want to install DVB-C channels, select the “CABLE” option and press the “OK” button on the remote control to

continue. To continue, please select “YES” and press “OK”. To cancel the operation, select “NO” and press “OK”.
Aerial & Cable installation

Using this option TV will search for all available TV channels DVB-C + DVB-T plus Analog and install them on a single
list.

You can select frequency ranges from this screen. For highlighting lines, use the “V “or “ A” buttons. You can enter
the frequency range manually by using the numeric buttons on the remote control. Set the Start and Stop Frequency
as desired by using the numeric buttons on the remote control. After this operation, you can set the Search Step as
8000 KHz or 1000 KHz.

If you select 1000 KHz the search will take longer, since the TV needs to check more frequencies. Depending on your
Country selection in the first time installation, A 250 KHz search step option might be available on the Network
Channel Scan screen. Note that if you perform the search with 250 KHz option, the search process could take longer.

\ 858.00 MHz
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Press “OK” to start the installation process. During this progress the bar will fill and found channels will be added to
the list.

Note: If option Aerial & Cable option is selected, when DVB-T channel search is complete, you need to define the start
frequency, end frequency and step for DVB-C channels. If you don’t know those values, use the default ones and press
“OK” to start the search.

When the automatic channel installation is complete, the following summary appears.

Edit Channel List

2. BBC Two Eng

3. BBC One West
4. (Beebies

5. BBC One East W
6. BBC One CI

7. SATA

8. ProSieben

9. kabel eins

‘ Move Edit name Lock
Function %Navigale OK| Watch
Exit Back [0 jump [on-Jeme] Page UP/DOWN

Here you can move, edit or lock channels. The information bar displayed on the bottom part of the screen will guide
you through the option that you are using.

Now you can press “MENU” to exit the installation page or you can press the “OK” button to watch TV.

10
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Pressing the MENU button will bring the MENU with all options active.

5. Picture

Picture

Accessing the picture submenu will bring the following menu on the screen:

L. Picture Settings t‘
- Contrast 60

- Brightness 32

- Sharpness 12

- Colour 35

Power Save Mode

Backlight Auto

Noise Reduction Medium

Advanced Settings 0K

Reset 0K

e e
%Ndvigale [€1®] change Value
Exit

The option which can be set:

- Mode: Can be set to one of these options: Cinema, Game, Dynamic and Natural.

- Contrast: Sets the difference between the brightest and darkest of the screen.

- Brightness: Sets the brightness value for the screen.

- Sharpness: Sets the sharpness value for the objects displayed on the screen.

- Color: Sets the color value, adjusting the colors.

- Power Save Mode: To set Power Save Mode to ON or OFF

- Backlight: This setting controls the backlight level and it can be set to Auto, Minimum and Maximum.
Backlight function will be inactive if Power Save Mode is set to ON. Backlight cannot be activated in VGA,
Media Browser mode or while the picture mode is set to Game.

- Noise Reduction: If the broadcast signal is weak and the picture is noisy, use the Noise Reduction setting to
reduce the noise amount. Noise Reduction can be set to one of these options: Low, Medium, High or Off.

- Advanced settings: Press “OK” and you will access the advanced options for the Picture menu.

- Reset: This option will reset all values for image to default.

Pressing the Return button will return you to the main menu. Pressing the MENU button will exit you from the
MENU.

11
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6. Sound

The sound options are available from the main menu:

Sound

Select and press “OK” to access the submenu:

B Sound Settings

Volume ——— )
Equalizer User
Balance e —\
Headphone ———————0
Sound Mode Stereo
AVL off

Digital Out PCM

Navigate | 4] P | Change Value
Back | & |Exit

The options available are:

- Volume: Adjusts the volume level.

- Equalizer: In the equalizer menu, the preset can be changed to Music, Movie, Speech, Flat, Classic and User.
Press the “MENU” button to return to the previous menu. The equalizer menu settings can be changed
manually only when the Equalizer Mode is in “User” mode.

- Balance: This setting is used for emphasizing left or right speaker balance.

- Headphone: Sets headphone volume.

- Sound Mode: You can select Mono, Stereo, Dual | or Dual Il mode, only if the selected channel supports that
mode.

- AVL: Automatic Volume Limiting (AVL) function sets the sound to obtain fixed output level between
programs (For instance, volume levels of advertisements tend to be louder than programs).

- Dynamic Bass: Press “«“ or “»” button to set Dynamic Bass to on or off.

- Digital Out: Sets digital out audio type.

Pressing the Return button you will return to the main menu. Pressing the MENU button you will exit from the
MENU.

12
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7. Settings

B G Y W R,

Settings

The submenu can be accessed by pressing “OK” when this menu is highlighted.

Language
Parental
Timers
Date/Time
Sources

Other Settings

The options available are:

- The Conditional Access: Controls conditional access modules when available.
- Language: Configures language settings (-may change depending on the country selected) Preferred and
current settings will be available.

English
English
West

English

None
None

13
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Parental: Configures parental settings including PIN code, Menu lock, Maturity Lock and Child Lock.
Timers: Sets timers for selected programs. / Sets sleep timer to turn off the TV after a certain time.

Date/Time: Sets date and time.

Note:* The TV takes the time info via the broadcast. Correct time will be available on Date/Time Settings, if the time info is
provided in the broadcast. If the TV is in no channel mode, Date/Time settings can be changed. However, if there is a channel preset,
only “Time Settings Mode” can be changed and if this is set to Manual, Time Zone will be enabled.

* If the TV is switched to standby mode and switched on later and there is no broadcast available, time information will not
be updated. If there is a present broadcast; however, time information will be taken via the broadcast. In other words, time
information will be available according to these priorities: The TV first looks for the time info in the broadcast, then to the user
preference, and lastly to the teletext time information.

Sources: Enables or disables selected source options.

Other settings:

| Other Settings

Menu Timeout

Scan Encrypted Channels

Blue Background

Software upgrade VEM141HE_0.7.78

Application Version VEM141HE_0.5.83
Hard Of Hearing off

Audio Description off
Auto TV OFF 4 Hours
Power Up Mode Last State

Country : Germany

[ it [€I®] change Value [FTa] Navigate

Menu Timeout: The amount of time for displaying the
menu and can have different values OFF, 15 sec, 30 sec and
60 sec.

Scan Encrypted channels: Set the behavior for encrypted
channels; If set to NO, all encrypted TV channels will be
skipped.

Blue Background: Enables and disables a blue screen
instead of channel

Software Upgrade: Press “OK” to access the menu where
you can disable or enable the Automatic scanning or trigger
a manual upgrade.

Note: If automatic scanning in the Upgrade Options menu is
enabled, the TV wakes up at 03:00 and searches broadcast
channels for new software upgrade. If new software is
found and downloaded successfully, with the next power up
the TV starts with new software version. In a hotel the safe
approach will be to disable this option.

Application Version: Is the software version currently
installed on TV.
Hard of Hearing: Audio help for impaired persons.

Audio description: Refers to an additional narration track
for blind and visually impaired viewers of visual media,
including television and movies.

Auto TV OFF: You can set the timeout value of the auto off
feature. When the timeout value is reached and the TV is
not operated for selected time, the TV will go off.

Note: Auto switch OFF is a UE regulation for reducing the
power consumption.

Power Up Mode: Defines the behavior of the TV in case of
power cut.

Last state: When power is restored the TV will return to the
same state before power cut.

Standby: When power is restored the TV will go by default
to standby. This is the recommended setting.

14
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Install and Retune Menu Content all options related to channel installation.

@ G % N v =

Install and Retune

The install and retune menu contains options for automatic channel install, manual channel install, network scan,
analog fine tune for a better reception of the analog TV channels. The first time installation option will delete the TV
channels and set all settings to default values, except Hotel TV settings.

B Install and Retune

Manual channel scan
Network channel scan
Analogue fine tune

First time installation

Automatic Channel Scan (Retune): Displays automatic tuning options available.

Digital Aerial: Searches and stores aerial DVB-T channels.

.‘At\channel scan (Retune) Digital Cable: Searches and stores cable DVB-C channels.

Digital Cable

Analogue Digital Aerial & Analogue: Searches and stores aerial DVB-T

and analogue channels.

Digital Aerial & Analogue

Digital Cable & Analogue Digital Cable & Analogue: Searches and stores cable DVB-C
Aerial & Cable and analogue channels.

Aerial & Cable: Searches and stores DVB-C, DVB-T and analog
channels.

Note: Using any of this option will delete the current channel plan. If you are sure, select “Yes” and press “OK”

15
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Manual Channel Scan: This feature can be used for direct broadcast entry.

B Install and Retune

Automatic channel scan (Retune)

Network channel scan
Analogue fine tune

First time installation

Search Type: Type of the channel to install
Digital Cable, Digital Aerial or Analog
Channel: The preset frequency

Frequency: Input for the frequency
Network scan: Enable or disable the network
scan

Signal quality & Signal Level

498.00 MHz

J Disabled

These two options will show the quality and
Signal quality: level of signal received on the frequency
Signal level: defined above.

Network Channel Scan: Searches for the linked channels in the broadcast

system. [- | nstﬁall—ﬂﬁetu ne

Automatic channel scan (Retune)
Manual channel scan
Analogue fine tune

First time installation

Analogue Fine Tune: You can use this setting for fine tuning analogue
channels. This feature is not available if no analogue channels are stored. - “;taﬁ andiRézjn(e‘

Automatic channel scan (Retune)

Manual channel scan

Network channel scan

First time installation

16
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First Time Installation: Deletes all stored channels and settings, resets the TV to factory settings and starts the first

time installation. You can follow the instructions in the Initial Installation section for more information on this
process.

B Install and Retune

Automatic channel scan (Retune)

Manual channel scan
Network channel scan

Analogue fine tune

17



8. Channel list

For channels options like: reorder, rename or lock you have to access the menu from the picture below. Channel
management can be also done with channel editor application available for PC. Check appendix 1 for channel editor

installation and usage.

Press “OK” for the submenu.

B G % Y (M= .

Channel List

Note: If the following menu is not displayed in the menu, please go and disable the Hotel TV mode.

Channel List

Favourites

Active Channel List

Export Channel List to USB
Import Channel List from USB

Edit channel list:

The channel list with all TV channels installed will be displayed.

18
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With the up and down arrow buttons you can select the channel and with the left and right arrow buttons the
function which will be used for that channel.

To move a TV channel in the list you need to do something similar. Select the TV channel with the up or down arrow
buttons, and then select the Move function and press “OK”. The TV will display a new window in which you must
enter the new position of the channel.

The channel plan will be updated after you press “OK”.

Favourites: Allows adding a channel to a particular list. To add a channel to the list select the channel using Up or
Down arrow and press “OK” to make the selection. A pink star will appear next to the channel name.

Edit Channel List

Active Channel List
Export Channel List to USB
Import Channel List from USB

Active Channel List: This option allows you to toggle between different types of lists: TV Only, Radio Only, Text Only,
Analog TV only and Favourites. These options are available for the Digital Cable and Aerial.

Edit Channel List

Favourites

Export Channel List to USB
Import Channel List from USB

19
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Export Channel list to USB: This option will export the channel to USB. The exported channel plan can be
managed on a PC using the Channel Editor Application. See appendix 1.

Note: The USB drive must be formatted as FAT32.

Edit Channel List

Favourites

Active Channel List

Import Channel List from USB

Import Channel list from USB: This option will import the channel plan from a USB stick. Make sure that only
channel plans managed with the Channel Editor are imported from a USB stick.

9. Media Browser

Media Browser

You can play photos, music, and movie files stored on a USB disk by connecting it to your TV. Connect a USB drive to
one of the USB inputs located on the side of the TV. The TV will read the content and provide an option to browse
the USB drive. Inthe Media Browser setting the following items are available: Videos, Photos, Music and Settings.

Files which can be played by the TV will be displayed inside the category. If the file is not available in none of the
category it means that file is not supported by the TV.

You can set your Media Browser preferences by using the Settings Menu.

IMPORTANT! Back up your files before making any connections to the TV. The manufacturer will not be
responsible for any file damage or data loss. Certain types of USB devices, for example, MP3 players or USB hard

disk drives/memory sticks may not be compatible with this TV.
20
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10. Professional Settings

Hotel TV Menu

Hotel Mode
Pin8

Last Status
Panel Lock

RCU Inhibit
Startup Position
Startup Channel

Volume Limit

Fixed Volume Enable

Fixed Volume Value

Headphone Direct Volume Disabled

0sd Disable Disable Setup Menus
On
ve

oHf
off

HOMIT

[Hotel Mode]
Feature to enable or disable the Hotel TV Menu features.

Note: When enabled, the TV will follow configured feature settings. If the Hotel
Mode is set to OFF, none of the settings from this menu will be active.

[Pin8]
Feature to enable or disable the auto SCART feature

Note: This feature allows a connected SCART device to turn the TV on or off.

[Last status]
This feature allows the TV to remember the last used configuration and restore
when startup again. Otherwise default settings are used.

[Panel Lock]

Feature to enable or disable the functionality of the side control TV button.
Select [On] to lock the side control TV button.
Select [Off] unlock the side control TV button

[RCU Inhibit]

Enable or disable the functionality of the Remote Control.
Select [On] to block all RC commands

Select [Off] and all RC commands are enabled.

21



[Startup Position]

Select startup program/source when TV is switched on via Power On key or Digit
keys.

¢ Auto TV wakes up in last used channel/source.

e TV: The TV set wakes up with the channel specified in Startup Channel field

¢ SCART / Side AV / HDMI1/ YPbPr / VGA_PC

[Startup Channel]

Feature to select the startup channel.

[Volume Limit]
Feature to set the maximum volume level.

Off

off

Off

Off

HOMIT
1

S ———

off
—_—

Disabled
Disable Setup Menus

Selectable values between 0-63.

[Fixed Volume Enable]

Feature to set Volume to a set Fixed Volume
Volume is fixed to the level defined at the option: Fixed Volume Value

[Fixed Volume Value]

Feature to set the Fixed Volume value.
Selectable values between 0-63.

off
Fixed Volume Value
Headphone Direct Volume Disabled

0sd Disable Disable Setup Menus

[Headphone direct Volume]

Controls Head Phone out volume instead of TV speakers.
TV speakers volume are set to Last Status before Hotel Mode is activated

22
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Feature to hide menu items when the Remote Control Menu key is pressed.
- * Disable All Menus :all menu icons are hidden

o
& ¢ Disable Setup Menus: Picture, sound, settings and media browser menu icons
o ll are displayed.

: When [Hotel Mode] is set to Off, all TV menu items will be displayed (picture,
sound, settings install and retune, channel list, media browser).

If OSD Disable is set to Disable All Menus, the EPG will not be displayed.

[Teletext]

0sd Disable
Teletext

Feature to hide the Teletext display.
¢ On: to enable Teletext activation.
¢ Off: to hide Teletext.

[Copy To USB]

Feature to copy configuration and channel settings. Press “OK” to copy settings
to a USB device connected on the side USB connector.

[Copy From USB]

Feature to copy configuration and channel settings from a USB device. Select
“OK” to copy settings from a USB device

[Wakeup Time Channel]

Feature to set the channel to view when the TV wakes up.
e Use the digits button(s) on the remote to complete the entry field

All timers and events are not possible to set once all menus are hidden.

[Wakeup Time Volume]

Disable Setup Menus

On

i Feature to set the wakeup time volume level.
oK Selectable values between 0-63.

0

——y A
On
Off
On
off
On
Off

23
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[USB option]

Feature to detect if a USB device is connected.
* On: to enable USB device detection.

¢ Off: to disable USB device detection.

When [Off] the Media Browser icon will be displayed but cannot be activated.

[Fixed Pic. Mode]
Feature to hide the picture menu icon

¢ Off: picture icon is displayed amongst all menus.
¢ On: picture icon is hidden

[Digital Tuner]

¢ Off: mixture of analog and digital channels
¢ On: digital channels only

[Multiple RC support]

Feature to enable the Multi RC.
o Off: feature is disabled
¢ On: feature is enabled and shows which RC is set

[Welcome Screen]

Feature to show a welcome screen at startup
¢ On: a welcome screen is shown
e Off: a welcome screen is hidden

[NIT Update]
If this option is enabled LCN information’s will be updated automatically. This
option is available only for Nordic countries.

Recommended action is to disable NIT table.

NIT Update

24



Hotel TV Meny

Disable Setup Menus

On

Hotel TV Meny

Teletext

High Security

Reset to Default Values

Digital Tuner
Multiple RC support

NIT Update

High Security

Reset to Default Values

EPG Enable/Disable

PHILIPS

If you set this option as ON, the Hotel TV menu will be accessible only with Philips
master remote control.

[High Security]

[Reset to Default Values]
Highlight this option and press the OK button on the remote to return the TV to
default settings.

Note: Only Hotel TV options will be affected by this action. TV channels will not
be deleted.

[EPG Enabled/Disable]

Enabling this option will make EPG available when Hotel TV mode is active.
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11. Welcome Logo

Once this feature is configured and set, the welcome image will be displayed within 8 seconds after switch on. This
page will remain until a key on the RC is pressed.

How to upload Welcome Logo
1. Create a graphics file: 960 x 540.png with the logo. Maximum size of the file is 150 kb.
2. File name: hotel_wel.png (File name is case-sensitive)
3. Create a folder named “welcome_image” on your USB key.
4. Save the image into the “welcome_image” folder on you USB key.
5. Insert the USB device into TV.
6. Enter the Hotel Mode.
7. Select the option: Copy from USB.
8. Make sure that option Welcome screen is set to ON

Note: For the welcome picture, there is a color lookup table used that is limiting the number of colors available to
display. This can result in certain display color artifacts and using a limited number of different color values can
improve this.
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With cloning it is possible to copy to/from a USB device the configuration data and the channel list data from a TV.
Place a USB Memory stick in the USB side connector of the TV.
*The USB device should be formatted as FAT or FAT32.

12. Clone

Access the Hotel Mode Menu with the RC 8573 (yellow remote) or with the guest remote by entering the key
sequence 3,1,9,7,5,3,MUTE and navigate with the TV remote to following items:

[Copy from USB]
1. Select [Copy from USB] and press OK.
2. The clone data will be loaded from the USB device into the TV.
3. Wait until the OSD message returns to its earlier state before removing the USB device.
4. Power down the TV and remove the USB device.

[Copy to USB]
1. Select [Copy to USB] and press OK.
2. The clone data will be loaded from the TV into USB device.
3. Wait until the OSD message returns to its earlier state before removing the USB device.

Content of the USB key:

I—— —
ter » (G:)STORENGO » v |43 Il Ses

ith Burn New folder

CLONEO000L

Because the clone data is stored inside a folder, multiple clone data can be stored on the same USB key.

The cloning is compatible between all screen sizes.
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9. Feature settings

[Multi RC]

Enter the MultiRC Menu Feature to configure the remote control to work with one TV. To enter the MultiRC Menu
on TV press the key sequence: MENU, RETURN, 1,2,3,4. On the TV a menu will guide you to select the desired TV
configuration. Choose a number between 1 and 4 to assign to the TV. Afterwards configure the remote control for

the same number as the TV by keeping MENU (HOME)+ the Digit pressed for 5 seconds.
The HFL2809 supports a maximum value of four remotes. The default value is Remote 1.

Remote 1: Press MENU (Home) + 1 (for 5 seconds).
Remote 2: Press MENU (Home) + 2 (for 5 seconds).
Remote 3: Press MENU (Home) + 3 (for 5 seconds).
Remote 4: Press MENU (Home) + 4 (for 5 seconds).

Example: TV is configured for Multi RC 2.

Remote control: Press MENU (Home) + 2 (for 5 seconds).

!INote: Before disabling the Hotel TV for any reason, reset the multi RC to default. The reset procedure is explained
below.

Enter the MultiRC Menu Feature to reset the MultiRC feature for the TV or for the remote control.
To enter the MultiRC Menu:
* Press key sequence: MENU, RETURN, 4,3,2,1

On the TV you will see a dialog, “Reset OK?” Press the OK key to reset the system. After resetting, the system will
return to the factory default.

To reset the remote control to default value press MENU + 1 (for 5 seconds).
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10. CSM (Consumer Setup menu)
Enter Service Menu

It is only possible to enter the Service Menu if the Hotel Mode is disabled. Enter the Hotel Mode menu and set the
Hotel Mode to “Off”

To enter the Service Menu:
¢ Press the following key sequence: Menu, 1,2,3,6,5,4

No items can be selected in the Service Menu. The software version number will show as VES141HE_x.y.z

SERVICE MENU ( VEM141HE 0.7 78) ) (SVN: 130499)(/0009df/6062ﬁ
Video Settlngs Sligh

Audio Settings i —
Options 1

Options 2

Options 3

Tuning Settings

Source Settings

Diagnostic

USB Operations

Model No: 7)5@@ Serial No:

TV Life Time : 1493 minutes Tv APS Time: Fri 14/02/2014, 16:15
Bootloader:v 1.9

PCF: 28 VESWNVX NO1_169WXGA E N NO_P_NO_ER XX 82_(04)
PTF: 28’ VESWNVX NO1_ 169WXGA_E_N_NO_P_ NO [R X(82_(v.0.0.1)
POF: pq_full hd (62)

AQF: AQ_6W _PEQ9 SR2 (V0000003 )
82SR2TP23154186NMDE3SP_15928_MB0002HCO2YEV076
05.02.2014_SAMPLE

HW Profile Version: 033 SW Profile Version: 092 Lan Profile Version: 170
Boot Logo Name: NULL
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Appendix 1

Channel List Editor

The Channel List Editor PC tool enables editing exported XML channel list files in a way that is more understandable
and user friendly.

Note: XML means Extensible Markup Language

Channel list should be exported from a TV set using the option available in the following menu (make sure that Hotel
mode is set to OFF):

Insert the USB key on the side connector of the TV.
Enter the MENU and navigate to Channel list.
Select the option “Export Channel list to USB”.

P wnNPR

When the process is complete remove the USB key.

The PC Tool can create a new empty channel list without importing channels on the TV, but we do not recommend
this mode of use due to the high level of possible errors that can be entered by the user (wrong parameters or
channel type).

When we export the channel list from the TV, on the USB drive there will be a file called “channelTable.xml” in the
root folder. You can open that list for editing from within the PC tool using the ‘Open’ option. It will import all the
channels and load them according to the Network Type (DVB-S, DVB-T...). Channels can be moved inside its Network
Type, added to favorites, channel info can be edited, removed, new channels can be added.

Multiple selection of the channel can be performed but the edit option is limited in that case depending on the
desired action performed. Moving channel triggers renumbering of the other channels depending on the move
result. There are two modes, LCN renumbering and non LCN renumbering.

For the Channel List editor we recommend usage of a PC with Windows XP or Windows 7 and .Net framework 2.0
and 3.5 should be installed. Currently only English is supported for the graphical user interface.
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Interface description and usage

1. Main window

s/ :XmiChanneiConfigurator 2.0.6 Hotel TV

File Edit Tools Help

| 1=

ol

Country: All

~ Genre: Al genre

7R & e

New Open Save Undo Redo Add Clone Edit Remove  List Settings Hél‘p

- Only Encrypted [

r
-2. kabel eins [DVB-T]

3. N24 [DVB-T]

.4 BBC One Lon [DVB-T]
5. BBC Two Eng [DVB-T]
- 6. BBC One West [DVB-T]

7. CBeebies [DVB-T]

8. BBC One East W [DVB-T]
~9. BBC One CI [DVB-T]
-10. SAT.1 [DVB-T]

~-11. ProSieben [DVB-T]
12. kabel eins [DVB-T]
13, N24 [DVB-T]
~14. SAT 1 Gold [DVB-T]
-15. SAT 1 Bayemn [DVB-T]
16. SAT.1 NRW [DVB-T]
~17. BBC Lifestyle [DVB-C]
.18. BBC Knowledge [DVB-C]
~19. Hustler TV [DVB-C]

20. Hustler Blue [DVB-C]
21. Bonus [DVB-C]

22. AVA [DVB-C]

- 23. Vintage TV [DVB-C]
-24. DR1 HD [DVB-C]

25. Das Erste HD [DVB-C]

26. arte HD [DVB-C]
~27. SWR BW HD [DVB-C]
+28. SVT1 [DVB-C]

29. SVT2 [DVB-C]

~30. SVT B/SVT24 [DVB-C]

Total number of channes: 84 | List version: 1 | Loaded list: H:\channelTable xml

e |DVB-T

PHILIPS

ProSieben

Digital television senvice (1)

All genre

ed 0 SE

17501

114500

The Main menu consists of pretty much the same options as the toolbar below, with the exception of “Save as” and

“Exit” options from the File submenu.

The “File” submenu consists of standard options as it can be seen on the Image 1-1 — File

o X miCH
File

Tools Help
1 New Ctrl+N AN
|L? Open Ctrl+O Iaﬁe
H Save Ctrl+S
Save As
Exit :

4 T__1Tmur

Image 1-1 — File

The “Edit” submenu consists of controls to “"Add”, “Edit” and “Delete” the current selected channels in the list.

g

L

File

Edit | Tools

Help

4+ Add new channel
7/ Edit channel

& Remove channel

pne |

1. C+ PORTADA
Image 1-2 - Edit
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The “Tools” submenu consists of “Settings” and “Preferences” (Image 1-2- Tools). “Settings” open the Channel
list settings dialog where a user can change Satellite configuration and Country (currently not used). “Preferences”
opens a dialog for managing application settings (Satellite names, Countries, User band values).

The “Help” submenu provides basic help about how to use the channel list editor tool.

_'
hanne%t 3
-

Edit | Tools | Help

W) E Settings ,
en  Sav Preferences Edit
/B-S

Image 1-2- Tools

The Toolbar provides shortcut icons for basic operations with channels and channel list.

The first group from the left provides file operations. Next to that are the options that provide channel managing
operations and the last group provides list settings and help.

™

| E

L) %

{&;3.@

New Open Save  Undo Redo @ Add Clone Edit Remove | List Settings Helb

Image 1-3 — Toolbar

Under the tool bar there is a list of channels from the loaded list sorted by network type in a tree view.

< L R SO RN

8.

. BBC Two Eng [DVB-C]
-2. BBC One Lon [DVB-C]

. BBC One West [DVB-C]

. BBC One East W [DVB-C]
. Das Erste HD [DVB-C]

. arte HD [DVB-C]

= 7. SWR BW HD [DVB-C]

SR Fernsehen [DVB-C]

--9. TVP Polonia [DVB-C]
-10.
2.
L A
-13.
14,
=15,
16,
AT
1B
19,

TVP INFO [DVB-C]
TVP Kultura [DVB-C]
TVP Historia [DVB-C]
CBeebies [DVB-C]
Bayern 2 [DVB-C]
Bayern 1 [DVB-C]
BR-KLASSIK [DVB-C]
hr-iNFO [DVB-C]
WDR 3 [DVB-C]
WDR 4 [DVB-C]

Image 1-4 - Channel list tree view

On the right part of the main windows the currently selected channel details are loaded. It consists of one mandatory

group:
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Image 1-5 - Common Service Params

And, depending on the Network Type of the currently selected channel, different additional groups can be displayed:

Image 1-

1
9901

116

6 - DVB Triplet

Values in DVB Triplet are only present when DVB channels are selected, for Analogue channels values in this group

are empty.

634000

128QAM

6875

Image 1-9 - DVB-C

When the form is in adding or edit state new buttons are added under the “Tuner Configuration” group:

Common Semvice Params
Network Type: [VE

Sevice Name
Channel Number
Senace Type
Country.

Genre

3 Locked

DVB Triplet
Network 1D

Senvice ID.

Transport Straam ID.

Tuner Configuration
Frequency
Modulation

Symbol Rate

1
Digital telewsion senwce (1)
"United Kingdom"

Al gence

47 Encrypted

634000
| 1280AM

6875

| Cancel

Image 0-7 - Edit state
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2. Editing chan

nel list

PHILIPS

The Channel list editing can be performed easily with use of the toolbar buttons: Add, Favourite, Clone, Edit,
Remove. More than one channel can be selected by holding SHIFT or CTRL and right mouse click.

EEEe i ok i PP—
[ |

File Edt Tools Help
[ ] I | & T; A ©
New Open Save Undo Redo | Add Clone | Edit | Remove | List Settings Help
Country: All ~ Genre: All genre ~ | Only Encrypted Common Senice Params
Network Type: DVB-C
B 1 B8C Two Eng [DVB-C] s D
i-2 BBC One Lon [DVB-C) . =
.3 BBC One West [OVB-C] SeNchhame:
" --4. BBC One East W [DVB-C] Channel Number. 1
- 5. Das Erste HD [DVB-C} .
-5, arte HD [DVB-C] Senice Type: | Digtal television senice (1) -
-~ 7. SWR BW HD [DVB-C) Country: ["Unit =
| -8 SR Femsehen [DVB-C] ey [ ad King ']
9. TVP Polonia [DVB-C] Genre: [AII genre vJ
-10. TVP INFO [DVB-C) : = |
il | 11 TVP Kultura [DVB-C] ¥ Locked (1 2 Encrypted (]
| -12 TVP Historia [OVB-C]
| -13. CBeebies [OVB-C] DVB Tnplet
| -14. Bayem 2 [OVB-C) <
* -15_Bayem 1 [OVB-C] Networs 323412
-16. BRKLASSIK [DVB-C] Sevice ID: 6302
-17. hr4NFO [DVB-C]
18 WDR 3 [DVB-C] Transport Stream ID: 115 0
119 WDR 4 [DVB-C] j
lj Tuner Confiquration |
Frequency. 634000 .
Modulation: [128QAM -
Symbol Rate: 6875 '
I Save ] } Cancel I
Total number of channes: 19 | List version: 1 | Loaded list: G:\channelTable xmi 1 |
= ————— —

Image 2-1 -

Add

Add — changes the state of the main form to add state and empty’s all the fields so the user can enter new values.
Only when in the add state the ‘Network Type’ combo box is enabled. When correct values are entered the user can
save with pressing the “Enter” key or pressing the “Add” button.

SHriChannelConfigurator 206 Hotel i e g T
i cnfgustos 206
File Edt Tools Help
= + P & e
New Open Save | Undo Redo |[Add|Clone Edt Remove | List Seftings Help
« Genre: All gense « Only Encrypted

Country: Al

B 1 85C Two Eng [DVB-C]

B8C One Lon [OVB-C)

3 /B4 ‘.
WOR 4 [DVB-C]

Total number of channes: 19 | List version: 1 | Loaded list: G:\channelTable.xml
=

Common Senice Params

Network Type
Sevice Name:
Channel Number.
Service Type

Digital telesision senvice (1)

DVB-C |-

Country

Genre

DVB Tnplet

Network 10
Semice ID.

Transport Stream ID.

Tuner Confiquration

Frequency

Al genre
§ Locked

7 Encrypted

Modulation

AUTO -

Symbol Rate:

T

Image 2-2 - Clone
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Clone - is much like Add just instead of leaving all the fields empty it will keep all the values from the previously
selected channel except for values that needs to be unique (Service Name, Channel Number...) for easy adding of
new channels on the same frequency. Depending on the Network type more or less parameters are copied. In case
the user changes the Network Type all fields will be cleared and drop back to regular Add mode. When the correct
values are entered the user can save with pressing “Enter” key or pressing “Add” button. Clone is disabled for
analogue channels because all analogue parameters need to be unique.

# XmiChannelConfigurator 206 Hotel TV ! B o )
Country: T v Genre Only Encrypted Cammon Service Params
Network Type' | DVB-C =
: . Sewce Name
Channel Number
] 6. mts HD OV " Service Type | Digital tolevision sendce (1) = B
Country | "United Kingdom™ -
Genre | Al genre -
y Locked /7 Encrypted '
DVB Tripiet
Network 1D
Senvice ID
Transport Stream 1D
"
W Tuner Confiquration
] Frequency 634000
I Modulation: | 128QAM =
Symbol Rate: 6875
Add Cancel

Total number of channes: 19 | List version 1 | Loaded kst: G \channefTable xmi

T

Image 2-3 - Edit

Edit — enables editing of the currently selected channel info. When correct values are entered the user can save with
pressing the “Enter” key or pressing the “Save” button.

Delete — removes the channel from the list. When a single service channel is selected and you are trying to delete, a
message will appear asking the user to confirm deletion of the channel with the corresponding name. In case more
than one channel is selected it will only inform the user of the number of channels that will be deleted.

T ]
|

File Edt Tools Help
= \ v &
ol = Il 5 X & e
New Open Save Undo Add Edit Remowe  List Settings Help

Country: Al Only Encrypted

Service deletion S

You are sbout to delete 4 services |
Do you want to proceed?

19. WODR 4 [OVB-C]

4 Total number of channes: 19 | List version. 1 | Loaded st G \channelTable xmi
\ =

Image 2-4 - Delete
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Move - Moving a channel or a selection of channels can be done using drag and drop options. Select the TV channel
and move it to desired position. Moving a channel will cause renumbering of the channels.

Note: you cannot assign numbers to TV channels, channel numbers will be assigned based on arranged list.
Move is possible only in the same subcategory; moving channel from DVB-S to Analogue will display the message
below (Error! Reference source not found.):

Info

|

Iol You cannot move to diferent Network types

Limitations and constraints

Image 1-8 - Info message

Service name length is not explicitly defined in DVB standard. Only limitation is the size (8bit) reserved for the value
in SDT descriptor that defines the service name length, this compiles to 255 char string.
Channel number or LCN can take values from 1 — 9999 as it is defined in the code. These limitations are applied in

the editor.

Save — when the channel list is according with the requirements press “Save” button for saving the channel list. This

option will rewrite the open file and save it in the same location.

If you want to save the file in another location please use the “Save As” option from the File menu.

3. Import channel list to TV

To import the channel list back to the

TV requires the USB drive with the file channelTable.xml saved on the root of

the drive. To import the channel list back to the TV the following steps should be followed (make sure that Hotel

mode is set to OFF):

P wnhe

Insert the USB key on the side connector of the TV.
Enter the MENU and navigate to Channel list.
Select the option “Import Channel list to USB”.
When the process is complete remove the USB key.

Do check the channel list before saving the cloning data.
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